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  Editorial


  Welcome to the latest issue of Full Circle.


  As ever, we have Python, Freeplane, Inkscape, but, unfortunately, no Great Cow Basic for you this month. Replacing Great Cow Basic for this month we have an article on encrypting your data with Cryptomator. Always better safe than sorry.


  As you may remember, from last month, Gord is unable to continue with his regular Q&A column. EriktheUnready (Telegram group mod extraordinaire) has stepped up and is going to give Q&A a try. So, round of applause for Erik. Q&A is probably one of the most popular parts of FCM. No pressure, Erik.


  We have a special news report about UBports (formerly Ubuntu) Touch. They've set the wheels in motion for the future by setting up a foundation. That future also holds an update from the old 14.x Touch to the new 15.x Touch that they've been working on. This brings big changes, and has been a long time coming. They're also implementing Android compatibility. This means your UBports Touch device will be able to run Android apps. This is big. No, BIG. As missing some apps is what often stops people adopting Touch. Now, there's no excuse. You really can have the best of both worlds with Touch.


  All the best, and keep in touch!


  Ronnie


  ronnie@fullcirclemagazine.org
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  NEWS


  Submitted by Arnfried Walbrecht


  
    Full Circle Weekly News
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    The show is also available via:


    
      	RSS: http://fullcirclemagazine.org/feed/podcast


      	Stitcher Radio: http://www.stitcher.com/s?fid=85347&refid=stpr


      	TuneIn Radio: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/


      	PlayerFM: https://player.fm/series/the-full-circle-weekly-news

    


    Enjoy! Ronnie

  


  


  SUSE Linux sold for $2.535 billion


  British firm Micro Focus International is selling its open source SUSE software to the Swedish group EQT Partners. The $2.535 billion deal boosted shares by 6 percent.


  SUSE Linux has been in the hands of Micro Focus International since 2014 and it has been running it as a largely independent division, competing directly with the likes of Ubuntu and Red Hat. The acquisition by EQT Partners means that more developers and engineers will be hired to work on the product.


  SUSE is the operating system of choice for many enterprise operations, as well as banks and governments. The new owners feel that an injection of cash, as well as not being based in the US, will very much work in SUSE’s favor….


  Micro Focus says the price paid by EQT is “highly attractive”, revealing that SUSE generated revenue of 

  $303 million and adjusted operating profit of $

 98.7 million in the year ending April 2017.


  Source: https://betanews.com/2018/07/03/suse-linux-sold/


  The Linux Mint desktop continues to lead the rest


  You can keep your Windows 10 and macOS High Sierra. For me, Linux Mint 19 is not only the best Linux desktop, it’s the best desktop. Period. End of statement.


  Why? Because its traditional windows, icons, menus, and pointers (WIMP) interface is a true pleasure to use. It’s even more fun now, because with Mint 19 and its default Cinnamon 3.8 desktop it’s faster and snappier than ever. The Cinnamon desktop, which uses the GTK 3.22 toolkit, also has a smoother look than previous versions.


  Linux, as ever, out of the box is more secure than macOS or Windows even after you strap on all the anti-virus software. On my Mac and Windows boxes, security is an almost daily job of patches and fixes. On my Mint desktops? I don’t even worry about it and I have never had a single security problem. I wish I could say the same about the competing operating systems.


  Installing software on Mint is mindlessly simple. Linux desktops are also fast on hardware you can find in a trash dump. High Sierra on my March 2015 vintage MacBook Air with 1.6GHz i5 processor and 8GBs of RAM runs as fast as trying to run through knee-deep mud. I am so, so not looking forward to running macOS 10.14 Mojave on it. Windows 10, on my Dell XPS 8700 with its 3.6 GHz Intel Core i7-4790 processor and 16GBs of memory, runs fast enough to be useful, but it’s not fast. Mint 19, on my 2011 Dell XPS 8300 with its 3.4GHz quad-core Intel Core i7 processor and 8GBs of RAM, charges along like a champ. No one in their right mind would run Windows 10 on that seven-year-old box.


  Source: https://www.zdnet.com/article/the-linux-mint-desktop-continues-to-lead-the-rest/


  MongoDB 4.0 released


  MongoDB is one of the so-called NoSQL databases (Not only SQL), which in favor of performance on some properties of relational database systems, e.g. Schema, locking mechanisms or dynamic queries, renounce. The schema-free MongoDB stores the data in BSON (binary JSON) structures, supports replication, and lends itself well to large objects such as video or large images. It is mostly implemented in C ++ and distributed under the Apache License 2.0 or the Affero General Public License (AGPL) 1.0.


  NoSQL databases promise much faster setup, better scalability, easier replication, and faster changes to data structures relative to relational databases. They are thus better suited to the requirements of high-traffic web services, which should always be available. This is also the basis for the success of MongoDB, which enjoys some popularity.


  MongoDB 4.0 extends the database with transactions, type conversions, and Kubernetes integration. The ability to transact makes it possible for the first time to change several documents in a consistent manner at the same time and to ensure that either all documents in the changed form have been taken over permanently or none. This warranty also covers the replicas of the database instance.


  Source: https://www.pro-linux.de/news/1/26055/mongodb-40-erschienen.html


  Linux Releases: elementary OS 5.0 Beta And CentOS 6.10 Are Here


  After much wait and anticipation, the elementary OS developers have shipped the first beta of their forthcoming “Juno” release. Being called a Developer Preview, it is aimed at the 3rd party developer and other users who are interested in testing the new features.


  This release cycle will primarily strive to deliver a better experience by incorporating different design and UX improvements. The designers have worked hard on the icons and modified about 1000 icon files. There has also been a jump from Gtk+ 3.18 to Gtk+ 3.22, resulting in a full rewrite of stylesheets.


  Ementary OS 5.0 has been updated with a new set of default wallpapers, new sound effects, night light feature, and better installation procedure. There are tons of other under-the-hood changes and bug fixes as well.


  Derived from the RHEL sources made freely available by Red Hat, CentOS is known for its ability to serve as a server machine as well as a daily driver.


  The latest CentOS 6.10 release comes loaded with many changes as compared to CentOS 6. All the updates since upstream 6.10 release have also been made available on CentOS mirrors.


  Source: https://fossbytes.com/centos-6-10-elementary-os-juno-beta-released/


  This new dual-platform malware targets both Windows and Linux systems


  One of the oft-repeated reasons for using alternative operating systems is the suggestion that alternatives to Windows are more secure because malware is not produced for these minority systems—in effect, an argument in favor of security by minority. For a variety of reasons, this is a misguided notion. The proliferation of web-based attacks—which are inherently cross-platform, as they depend on browsers more than the underlying OS the browser runs on—makes this argument rather toothless.


  In the more narrow view of actual executables, Java-based malware such as McRAT has proliferated in the past, though Java on the desktop is practically unheard of on consumer computers in 2018. Likewise, with enterprises moving away from installing Java SE on workstations, the viability of that approach has dwindled. However, Google’s Golang—which supports cross compiling to run on multiple operating systems—is now being utilized by attackers to target Windows and Linux workstations.


  According a report by JPCERT, the WellMess malware can operate on WinPE (Windows Preinstallation Environment) and on Linux via ELF (Executable and Linkable Format). The malware gives a remote attacker the ability to execute arbitrary commands as well as upload and download files, or run PowerShell scripts to automate tasks. The commands are transferred to the infected device via RC6 encrypted HTTP POST requests, with the results of executed commands transmitted to the C&C server via cookies.


  Source: https://www.techrepublic.com/article/this-new-dual-platform-malware-targets-both-windows-and-linux-systems/


  Ubuntu bug allows anyone with physical access to bypass your lock screen


  A bug filed on Ubuntu Launchpad in the middle of June has just been made public. The bug in question appears to allow anyone with physical access to the computer to bypass the lock screen by just removing the hard drive. The bug was tested on Ubuntu 16.04.4 and it’s unclear whether it affects other versions of Ubuntu or other distributions but there’s an almost certain chance it affects other distributions based on Ubuntu 16.04, such as Linux Mint 18.


  The attack works in the following way, a user boots into Linux and opens up their programs and files, then the machine is suspended and it goes into low power mode and writes the state of the machine to memory. At this point an attacker can remove the hard drive and wake up the system; now they’ll either see the lock screen and be able to enter any password to gain access. They might try the password and be denied access at which point they can fast press the hardware shut down button and gain access, or no lock screen will appear but instead the screen will be black and the previous steps can be attempted.


  Source: https://www.neowin.net/news/ubuntu-bug-allows-anyone-with-physical-access-to-bypass-your-lock-screen


  Malware found in Arch user repository AUR


  Arch warns on its website: “AUR packages are custom content. The use of the provided files is at your own risk”. That the warning should be taken seriously and the PKGBUILD files in the AUR, the arch repository with user-created and maintained packages, should always be checked prior to installation, unless the creator is trusted, proved to be a malware threat over the weekend. Code in the acroread package. An attentive user had reported the package. What the creator meant, one can only guess.


  The compromised packet that had previously been orphaned for a while had been taken over by a user with the nickname “xeactor”. He had inserted a script that creates a systemd service that collects technical data about the affected system and sends it to a pastebin. However, “xeactor” made a mistake because his script did not work as expected. Two more packages were compromised in the same way. All affected packages are now removed and “xeactor” locked out.


  Source: http://www.pro-linux.de/news/1/26074/malware-im-arch-user-repository-aur-gefunden.html


  Minimal Ubuntu for containers and clouds


  By default, Linux comes with a lot of extras. Usually, that’s a good thing. But, sometimes you want just the bare necessities of Linux life for your server, containers, and clouds. That’s where Canonical’s latest Ubuntu release, Minimal Ubuntu, comes in.


  When Canonical says “Minimal”, they mean minimal. Weighing in at a mere 29MB for the Ubuntu 18.04 Docker image, Minimal Ubuntu could fit on a CD with hundreds of Megabytes to spare.


  This is far from the first time Canonical has offered a small-footprint Ubuntu. The minimal Ubuntu ISO image, about 40 MB, is meant for people who download packages from online archives at installation time.


  While that release is useful mostly for hobbyists, Minimal Ubuntu 18.04 Long Term Support (LTS) serves as an efficient container operating system. It enables developers to deploy and boot multi-cloud containerized applications faster. The minimal Ubuntu image is already being used as the standard Docker Hub Ubuntu 18.04 LTS image.


  As Paul Nash, the Google Cloud Group Product Manager, said in a statement, “The small footprint of Minimal Ubuntu, when deployed with fast VM provisioning from GCE, helps deliver drastically improved boot times, making them a great choice for developers looking to build their applications on Google Cloud Platform.”


  It’s not just true on Google Cloud. These advantages work on any cloud. It’s available on Amazon EC2, Google Compute Engine (GCE), LXD, and KVM/OpenStack.


  Source: https://www.zdnet.com/article/minimal-ubuntu-for-containers-and-clouds/


  Debian ‘Stretch’ 9.5 Linux distribution available for download


  Debian 9 “Stretch” was released over a year ago – time really flies! Since then, the wildly popular Linux distribution has been downloaded by countless users.


  Today, the 5th “point” release becomes available. In other words, Debian Linux “Stetch” has reached an important milestone – version 9.5 stable. The operating system is always improving with security updates and bug fixes, and 9.5 is no exception here. In fact, it includes a patch for Spectre V2. Also of significance, the Debian Installer has been given an update.


  “The Debian project is pleased to announce the fifth update of its stable distribution Debian 9 (codename ‘Stretch’). This point release mainly adds corrections for security issues, along with a few adjustments for serious problems. Security advisories have already been published separately and are referenced where available,” says The Debian Project.


  The project further says, “Please note that the point release does not constitute a new version of Debian 9 but only updates some of the packages included. There is no need to throw away old ‘stretch’ media. After installation, packages can be upgraded to the current versions using an up-to-date Debian mirror. Those who frequently install updates from security.debian.org won’t have to update many packages, and most such updates are included in the point release.”


  Source: https://betanews.com/2018/07/14/debian-linux-stretch-95-download/


  WellMess: This Go-based Malware Attacks Both Linux And Windows Machines


  There’s no doubt that Linux and Mac are more secure operating system choices as opposed to Microsoft Windows. But this doesn’t mean that hackers don’t find ways to infect the machines running these operating systems — in the past, we came across the massive Mirai botnet that controlled the networking devices running Linux.


  Mirai creators used Golang (also called Go) programming language to write the code of the malware. Just recently, the security researchers at JPCERT have found another malware written in Go; it even features the cross-platform capability and comes in two versions.


  Named WellMess, this malware affects both Linux and Windows operating systems. While the basic functionality of the both versions of the malware remains the same, there are some minor differences.


  Just like other malware, WellMess communicates with its command & control (C&C) center and downloads commands for further actions. The commands could be given from C&C server to upload/download files and execute arbitrary shell commands. The Windows version further has the ability to run PowerShell scripts.


  The commands are sent to the infected devices in the form of RSA-encrypted HTTP Post request; the cookie header data is RC6-encrypted. That’s not all. WellMess also has a version developed in .Net Framework. The cookie data in the .Net version is same as Go version.


  Source: https://fossbytes.com/wellmess-malware-go-linux-windows/


  Atari VCS RAM Doubled To 8GB; Will Ship With Linux-based Distro “AtariOS”


  After organizing the Atari VCS crowdfunding campaign to collect money and creating the hype for the upcoming Atari VCS console, the console has received a major update in the hardware.


  As compared to the previously announced 4GB RAM which somewhat made it look like any other console out there, Atari VCS project’s System Architect Rob Wyatt announced that the console will now ship with 8GB of DDR4 RAM.


  In a Q&A blog post on Medium, Rob who is also one of the leading men behind the original Xbox System, announced the memory boost along with some other insights of the console.
 As the company is reaching closer to the development process, the new announcement has further boosted the hopes of gaming enthusiasts.


  Speaking of controllers, Atari Classic Joystick and the Atari Modern Controller are the standard input devices. Additionally, AtariOS, the custom Linux-based OS, will have a standardized controller support with a built-in controller remapping tool which will allow users to remap physical controller buttons to logical standardized buttons.


  Explaining the details of AtariOS, he said, “Our core architecture consists of the Atari Secure Hypervisor and a heavily modified Linux kernel called the AtariOS. All of this is in flash memory, and before the AtariOS loads, any external storage device is checked, and if a bootable device is found, the OtherOS on that device is loaded instead.”


  This separation of AtariOS and OtherOS will result in denied access to Atari services when the OtherOS is running.
 It is expected that the Atari VCS will be ready to ship by July 2019.


  Source: https://fossbytes.com/atari-vcs-ram-atarios-linux-distro/


  Red Hat Enterprise Linux 6 & CentOS 6 Patched Against Spectre V4, Lazy FPU Flaws


  Users of the Red Hat Enterprise Linux 6 and CentOS Linux 6 operating system series received important kernel security updates that patch some recently discovered vulnerabilities.
 Now that Red Hat Enterprise Linux 7 and CentOS Linux 7 operating system series were patched against the Spectre Variant 4 (CVE-2018-3639) security vulnerability, as well as the Lazy FPU State Save/Restore CPU flaw, it’s time for Red Hat Enterprise Linux 6 and CentOS Linux 6 to receive these important security updates, which users can now install them on their computers.


  As expected, the most important fix is that for Spectre Variant 4, an industry-wide CPU flaw that affects numerous modern microprocessor using a common performance optimization known as speculative execution of Load & Store instructions, which could allow an unprivileged attacker to read privileged memory via targeted cache side-channel attacks. Patches are now available for Intel x86 and AMD CPUs.


  The Lazy FPU state save/restore CPU flaw (CVE-2018-3665) was patched as well in this latest kernel security update to the Red Hat Enterprise Linux 6 and CentOS Linux 6 operating system series, which could lead to leakage of FPU state information. Additionally, the new kernel updates also address a use-after-free vulnerability in the mm/mempolicy.c:do_get_mempolicy function (CVE-2018-10675), which could lead to local denial of service attacks.


  Also fixed is a kernel error in exception handling (CVE-2018-8897 regression and CVE-2018-10872), which could also lead to denial of service attacks. Red Hat Enterprise Linux 6 users are urged to update their installations as soon as possible, and CentOS Linux 6 users should update their systems as well to kernel-2.6.32-754.2.1.el6.i686.rpm on 32-bit and kernel-2.6.32-754.2.1.el6.x86_64.rpm on 64-bit.


  Source: https://news.softpedia.com/news/red-hat-enterprise-linux-6-centos-6-patched-against-spectre-v4-lazy-fpu-flaws-521965.shtml


  Slackware, The Oldest Active Linux Distro, Turns 25


  On July 16th, 1993, Slackware Linux distribution was officially released. Based entirely on the Softlanding Linux System (SLS) system, it was designed for the machines with a 3.5” boot floppy. Over the past 25 years, Slackware has turned out to be one of the most influential Linux distros around.


  The very first releases of SUSE Linux and other open source pioneers were based on Slackware; its effect is also seen on other operating systems with “do it yourself” motto.


  For many Linux enthusiasts, it turned out to be the starting point of their Linux journey. Due to its vanilla experience and minimum customization offerings, it slowly developed a cult following. The project’s website calls it an effort to produce the most UNIX-like distribution with “the twin goals of ease of use and stability as top priorities.”


  Today, Slackware has witnessed more than 30 versions and it remains an active distribution. The latest release was shipped in 2016 as Slackware 14.2; it offered Xfce and KDE as the two choices for the desktop environment.


  Source: https://fossbytes.com/slackware-birthday-25-oldest-active-linux-distro/


  Pinguy OS Puts On a Happier GNOME 3 Face


  Pinguy OS 18.04 is an Ubuntu-based distribution that offers a non-standard GNOME desktop environment intended to be friendlier for new Linux users.


  This distro is a solid Linux OS with a focus on simple and straightforward usability for the non-geek desktop user. If you do not like tinkering with settings or having numerous power-grabbing fancy screen animations, Pinguy OS could be a good choice.


  The GNOME desktop is the only user interface option, but Pinguy OS’ developer, Antoni Norman, tweaked the desktop environment with some different software options not usually packaged with GNOME.


  His refusal to settle for the run-of-the-mill software typical of mainstream GNOME choices is one of this distro’s strongest features. The developer gives you better application options to create the best user experience within the modified GNOME environment.


  Pinguy OS is a great pick for beginning Linux users because it is easy to use and offers a satisfying experience. It is also a no-nonsense computing platform for seasoned Linux users who want a GNOME environment that makes more sense.


  Pinguy OS comes with user-friendly enhancements and out-of-the-box support for multimedia codecs and browser plugins. The modified GNOME user interface has enhanced menus, panels and dock bars. It includes a handpicked selection of popular desktop applications for many common computing tasks.


  Pinguy OS may not satisfy power users who like to control navigation with keyboard shortcuts and advanced system settings. However, if you just want your system to work from the start, Pinguy OS has a lot going for it.


  Source: https://www.linuxinsider.com/story/Pinguy-OS-Puts-On-a-Happier-GNOME-3-Face-85439.html


  System76 Linux computer maker offers a sneak peek into its new manufacturing facility


  System76 has long been a Linux computer seller, but recently, it has transitioned into a Linux computer maker. What’s the difference, you ask? Well, currently, the company doesn’t really make its own computers. System76’s laptops, for instance, are made by other manufacturers, which it re-brands as its own.


  No, System76 doesn’t just slap its name on other company’s laptops and ship them out the door. Actually, it works closely with the manufacturers, tweaks firmware, and verifies that both Ubuntu and its Ubuntu-based Pop!_OS will work well on the hardware. System76 then offers top-notch support too. In other words, the company isn’t just selling a computer, but an experience too.


  Unfortunately, when you rely on other computer manufacturers, you don’t fully control the experience. Ultimately, System76 cannot achieve its true vision without building its own laptops. And so, that is exactly what it is going to do! Yes, System76 will be building and selling the computers right here in the USA (Denver, Colorado to be exact). I mean, when your company supports open source ideology and takes pride in being “Made in America,” how can you go wrong?


  Many folks in the Linux community are excited to see the fruits of System76’s labor, and today, we get a small peek. No, the company isn’t sharing any of its upcoming computer designs, but it is showing off its new manufacturing facility.


  Source: https://betanews.com/2018/07/17/system76-linux-manufacturing-facility/


  Optimized Clear Linux Kernel Now Available for Fedora 28 and Fedora Rawhide


  Recent devel list discussion for popular Linux distro Fedora mentioned Clear Linux optimizations, which may be relevant to Fedora developers in the future. It was mentioned that Intel’s Clear Linux show noticeable performance gains over Xubuntu.


  It’s interesting for Fedora developers, as there is a little bit of debate whether or not Clear Linux kernels actually improve performance in any significant way, or if its entirely negligible. For example, when Phoronix tried a Clear Linux kernel for Ubuntu, all they managed to achieve was decreased boot times, but nearly all other tests showed only minuscule gains compared to the stock Ubuntu kernel.


  Thus, its important to remember that finely-tuned kernels are only one small part of the overall puzzle. There are many other tweaks involved, particularly amongst the Intel development team working on Clear Linux, where they apply various packages to the kernel, and some vital components such as Glibc, GCC, and compiler optimizations revolving around LTO, FMV, and PGO.


  Still, whether or not a Clear Linux kernel for Fedora actually makes any drastic performance improvements, the potential is what matters.


  Source: https://appuals.com/optimized-clear-linux-kernel-now-available-for-fedora-28-and-fedora-rawhide/


  Google has submarine cables moved from the US to Europe


  Google has hired specialist TE Subcom to relocate a submarine cable from Virginia Beach to the French Atlantic coast.


  The submarine cable project is named Dunant, after the Peace Award winner and founder of the Red Cross Henry Dunant. The four-fiber cable extends over a length of 6400 kilometers according to TE Subcom and is to supply further capacities to the global Google network. The Communication also states that links to other submarine cables in the region will be made. The costs for the project are not mentioned. Google expects completion by 2020. A submarine cable has a lifespan between 15 and 25 years, Google said.


  Google is already investing in its 13th cable project with the Dunant project. Most of them started Google together with consortia from other companies. With the project Curie, which is to connect Chile with Los Angeles, Google first appeared as a private client. Curie is scheduled to finish in 2019. The private investment also applies to Dunant.


  Source: http://www.linux-magazin.de/news/google-laesst-seekabel-von-den-usa-nach-europa-verlegen/


  SUSE launches new enterprise Linux to help the move to software-defined infrastructure


  Businesses are increasingly running a mix of traditional and software-defined architectures and the launch of SUSE Linux Enterprise 15 is aimed at bridging the gap between the two.


  It’s a modular operating system that helps make traditional IT infrastructure more efficient and provides an engaging platform for developers. It also aids in integrating cloud-based platforms into enterprise systems, merging containerized development with traditional development, and combining legacy applications with microservices.


  This ‘mulitmodal’ approach means organizations can easily deploy and transition business-critical workloads across on-premise and public cloud environments. To facilitate this it uses a common code base to ensure application mobility.


  Enterprise 15 includes ring-Your-Own-Subscription (BYOS) programs to streamline the use of or move to Amazon Web Services, Google Cloud Platform or Microsoft Azure. There’s also a custom-tuned kernel for workloads on Microsoft Azure to enable faster boot speeds with a decreased memory footprint.


  In addition a new Modular+ architecture makes everything in the OS a module. This means SUSE can deliver product updates and patches more frequently. The modular approach lets customers install only the features they need, making planning easier and cutting reducing risk. It’s also designed to integrate into commonly used modern development methodologies like DevOps and CI/CD.


  The product portfolio includes server versions for Intel, ARM and POWER systems, a server for SAP applications, desktop and workstation versions and more.


  Source: https://betanews.com/2018/07/19/suse-linux-enterprise-15/


  Linux Mint developers planning big Cinnamon 4.0 improvements


  Linux Mint is one of the most popular Linux-based desktop operating systems for a reason – it’s really good. By leveraging the excellent Ubuntu for its base, and offering a top-notch user experience, success is pretty much a guarantee.


  While the distribution primarily focuses on two desktop environments – Mate and Cinnamon – the latter is really the star of the show. Cinnamon is great because it uses a classic WIMP interface that users love, while also feeling modern. With Cinnamon 3.8, the Linux Mint Team focused on improving the DE’s performance, and today, the team shares that it is continuing that mission with the upcoming 4.0. In particular, the team is focusing on Vsync.


  I must say, it is refreshing that the Linux Mint Team is focusing on performance and “under the hood” improvements for Cinnamon 4.0. Quite frankly, the desktop environment is already quite feature complete and a joy to use. No, I am not saying the interface is perfect and the superficial should be ignored, but for now, it shouldn’t be a priority. The developers are absolutely on the right track with Cinnamon 4.0.


  Source: https://betanews.com/2018/07/20/linux-mint-cinnamon-4/


  Latest Neptune OS 5.4 brings many application improvements and bugfixes


  The Debian-based Linux distro Neptune OS recently announced a complete update to Neptune OS V5.4, which brings a large number of improvements and updates.


  For starters, the GUI has been given a general makeover with a package named Neptune Dark, which includes a modified icon pack called Faenza Dark, which is made for dark themes in mind.


  Hardware support was also increased by updating to Linux Kernel 4.16.16, which should address some drivers and bugfixes. Some other notable updates in this latest version include KDE Frameworks being updated to version 5.48, and KDE Applications updated to version 18.04.3. However, because he new KF5 version is incompatible with Qt 5.7, the Neptune OS developers needed to backport its patches to 5.45.


  As for software and app updates, VLC was updated to version 3.0.3 which should be generally much faster, with many bugfixes. Thunderbird 52.9 should fix issues with encrypted HTMLT emails, and the new Excalibur menu is available in its version 2.7, which fixes bugs regarding to multiple activities and shifting around your favourites.


  The default window manager for Plasma, named KWin, was updated to version 5.12.5 which was adjusted to be compiled against Qt 5.7 – users should see verifiable performance improvements, as well as nicer screen effects and better overall hardware support.


  LibreOffice was updated to version 6.0.6, and the Neptune OS devs fixed an issue with MTP causing issues when trying to share files to Android devices over an MTP connection.


  Finally, Enlightenment 22 was made available in version 0.22.3, together with Terminology 1.2.1


  Source: https://appuals.com/latest-neptune-os-5-4-brings-many-application-improvements-and-bugfixes/


  Google reportedly offered Android changes to EU in 2017


  The European Union may have characterized its $5 billion Android antitrust fine as punishment for an intransigent Google, but the practical reality might be different. Bloomberg sources have claimed that Google offered to make changes to its Android policies in August 2017, not long after it received an EU antitrust penalty for its product search practices. Although Google didn’t dive into specifics, it had offered to “loosen restrictions” in Android contracts and had considered distributing its apps in “two different ways.”


  The EU wasn’t having it, according to the sources. Officials reportedly said only that a settlement was “no longer an option,” and that Google’s offer was “too little too late.” It couldn’t even mention the possibility of paying a fine as part of an agreement – regulators had effectively locked in their course of action. Google had tried to talk about ending the probe considerably earlier than that, according to the tipsters, but regulators supposedly either stonewalled or said it was too early to negotiate. If so, there may have only been a brief window of opportunity for a truce.


  The revelations, if accurate, ultimately leave Google in the same boat: it’s now facing a giant fine and significant changes to its mobile strategy if its appeal doesn’t succeed. They do suggest that the penalty wasn’t inevitable, though, and that Google might well have implemented Russia-style changes months sooner if the EU had wanted to bend.


  Source: https://www.engadget.com/2018/07/22/google-reportedly-offered-android-changes-to-eu-in-2017/?guccounter=1


  Debian-Based Slax 9.5.0 Released, Now Available on Hardware-Encrypted USB Keys


  Since it’s been rebased on the Debian GNU/Linux operating system, Slax saw two releases, versions 9.3.0 and 9.4.0, which introduced numerous enhancements and new features, including one-click-to-install launchers, support for various Wi-Fi devices, EXT4 and NTFS support, and persistent support enabled by default when booting from USB flash drives.


  With the Slax 9.5.0 release, which incorporates all the latest security patches and software updates from the Debian GNU/Linux 9.5 “Stretch” operating system, the developer also announced the availability of a USB flash drive pre-installed with Slax and featuring hardware-based AES encryption, which can be purchased from the official website only with Bitcoin.


  According to the developer, the USB device is universally usable thanks to its hardware-based AES (Advanced Encryption Standard) encryption, which is done directly by the drive itself through keys and without any software (see the image below to see it in action). When removed, the USB stick automatically locks itself.


  So if you manage to purchase the new encrypted USB key with Slax pre-installed, you’ll be able to use the tiny Linux-based computer operating system like it was designed to be used from the very beginning, back when it was based on Slackware instead of Debian GNU/Linux.


  Source: https://news.softpedia.com/news/debian-based-slax-9-5-0-released-with-usb-key-with-hardware-based-aes-encryption-522072.shtml


  Canonical Fixes Boot Failures on Ubuntu 18.04 LTS and 16.04 LTS, Update Now


  About two weeks ago, Canonical patched a regression that would lead to boot failures on some AMD machines using the Ubuntu 14.04 LTS (Trusty Tahr) operating system series, which was caused by a microcode firmware update for AMD processors that was supposed to mitigate the well-known Spectre microprocessor side-channel security vulnerability.


  Earlier this month, on July 2, Canonical released a Linux kernel security update for Ubuntu 18.04 LTS (Bionic Beaver) users, addressing a total of six security vulnerabilities, one of which introduced a regression also causing boot failures, though it doesn’t appear to be limited to AMD processors only, but also to Intel machines.


  As Canonical allows users of previous Ubuntu LTS (Long Term Support) versions to use the Linux kernel of newer Ubuntu LTS versions, the patch for the said regression causing boot failures is also available for Ubuntu 16.04.4 LTS (Xenial Xerus) users that have the HWE (Hardware Enablement) kernel from Ubuntu 18.04 LTS (Bionic Beaver) installed by default.


  All Ubuntu 18.04 LTS and Ubuntu 16.04 LTS users are urged to update their installations to the new Linux kernel versions that are available in the main software repositories as soon as possible and reboot their computers after a successful installation.


  Source: https://news.softpedia.com/news/canonical-fixes-boot-failures-on-ubuntu-18-04-lts-and-16-04-4-lts-update-now-522073.shtml


  Linux 4.18-RC6 Brings Network and Driver Fixes Including 32-Bit VM Fallout Fix


  Linux users can now evaluate the sixth weekly test release of the Linux 4.18 kernel, titled Linux 4.18-rc6. This release brings a lot of networking fixes and resolves some other issues with previous releases, as the team focuses on bringing us closer to a stable kernel release.


  Most of the changes in Linux 4.18-rc6 revolve around networking fixes, but also driver and architecture updates, and a handful of other improvements. This includes fixes to GPU drivers, SCSI, NVMA, PCI, PinCTRL, arch updates to Arc, x86, NDS32, PowerPC, and also miscellaneous fixes for header files, VM and FS noise.


  The changelog is pretty massive with a lot of commits from various testers and developers, so read through the changelog on the kernel mailing list if you want a complete overview of what has been updated.


  The VM bug in earlier releases was fixed in the last RC, but there was apparently a bit of 32-bit fallout from the fix, so issues were still cropping up in RC5. However, the developers are hoping that RC6 has completely eliminated all of the issues.


  If everything goes according to the team’s plan, Linux 4.18-rc7 will be the last release candidate, followed by Linux 4.18.0 a week afterwards on August 5th, and we could see the actual stable kernel pushed out by August 12th. Fingers crossed!


  Source: https://appuals.com/linux-4-18-rc6-brings-network-and-driver-fixes-including-32-bit-vm-fallout-fix/


  Linux bots account for 95 percent of DDoS attacks as attackers turn to the past


  Cybercriminals are delving into the past to launch attacks based on some very old vulnerabilities according to the latest report from Kaspersky Lab, and they’re using Linux to do it.


  In the second quarter of 2018, experts have reported DDoS attacks involving a vulnerability in the Universal Plug-and-Play protocol known since 2001. Also, the Kaspersky DDoS Protection team observed an attack organized using a vulnerability in the CHARGEN protocol that was described as far back as 1983.


  In the top 10 of countries hosting the most active command and control (C&C) servers, the US leads, accounting for almost half (45 percent) of all active botnet C&C servers in Q2. Meanwhile, Vietnam joined the list while Hong Kong dropped out of the top 10.


  One of the most popular methods of monetizing DDoS attacks remains the targeting of cryptocurrencies and currency exchanges. In Q2, Verge cryptocurrency suffered an attack on some mining pools over the course of several hours, resulting in $35 million XVGs being stolen in the ensuing confusion.


  Gaming platforms continue to be a target as well, particularly during eSports tournaments. According to Kaspersky Lab, DDoS attacks affect not only game servers (which is often done to extort a ransom in return for not disrupting the competition) but also the gamers themselves who connect from their own platforms. An organized DDoS attack on a team’s key players can easily result in that team losing and being eliminated from a tournament. Cybercriminals use similar tactics to monetize attacks on channels streaming broadcasts of video games. Competition in this segment is intense, and by using DDoS attacks, cybercriminals can interfere with online broadcasts and, consequently, a streamer’s earnings.


  Source: https://betanews.com/2018/07/24/linux-ddos-attacks/


  Everything About Ubuntu’s New Default Theme “Yaru”


  If you follow the Ubuntu development process closely, you must be knowing about the Ubuntu Communitheme that has been under development for some time. In case you are a person who doesn’t like this name, here’s a good news.


  Canonical has announced details regarding the next default Ubuntu 18.10 Cosmic Cuttlefish theme, which is now called Yaru. This follows the Japanese influence on Ubuntu’s theme naming and it means “to do.” Ubuntu’s last icon theme’s name Suru also meant “to do,” but in a casual way.


  The Communitheme theme was going to ship as the default theme in the Ubuntu 18.04 LTS Bionic Beaver. To make it more polished and user-friendly, the developers decided to shift the same to the next release, i.e., Ubuntu 18.10.


  It is bow based on GNOME Adwaita theme and is a result of community collaboration. The Communitheme had been available for testing as a snap for quite some time now, and Canonical had been getting the feedback.


  If you take a quick look at the Ubuntu desktop running the theme, you’ll notice the flat design right away. It makes sense because flat design elements are trending these days and they give a cleaner look. However, to make it less boring, the designers have mixed it with the contours and GNOME shell’s existing elements.


  Based on the user feedback, over the past two months, many changes were incorporated in Yaru: the color and shape of buttons was made brighter and sharper; window and sidebar colors were made warmer; text selection color changed from orange to blue; and other changes to borders, shadows, colors, transparency, notifications, etc.


  Source: https://fossbytes.com/ubuntu-yaru-theme-new-try/
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    The Ubuntu Podcast covers all the latest news and issues facing Ubuntu Linux users and Free Software fans in general. The show appeals to the newest user and the oldest coder. Our discussions cover the development of Ubuntu but aren’t overly technical. We are lucky enough to have some great guests on the show, telling us first hand about the latest exciting developments they are working on, in a way that we can all understand! We also talk about the Ubuntu community and what it gets up to.


    The show is presented by members of the UK’s Ubuntu Linux community. Because it is covered by the Ubuntu Code of Conduct it is suitable for all. The show is broadcast live every fortnight on a Tuesday evening (British time) and is available for download the following day. podcast.ubuntu-uk.org
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  Comand&Conquer: Noteworthy Applications


  Written by Lucas Westermann


  I have been using the lull of the last month to read up on all the articles I save, and the videos I’ve added to my ‘watch later’ list. In this article, I plan to share some applications I’ve discovered through this reading, and a few general revelations.


  Cantata


  I’m the kind of person who works best with a bit of background music playing. For the longest time, my go-to music player was NCMPCPP and MPD (Music Player Daemon). However, in the course of sharing my music folder between my laptop and NUC, I decided I needed an application I could use to rename files and organize the folder in general. Enter Cantata. It’s a graphical front-end for MPD, meaning I could still use my playlists and NCMPCPP whenever I pleased. It also offers the ability to download album art, find album information when ripping CDs, and dynamic playlists. Overall, the application does way more than I ever really use, but also does exactly what I want when it comes to organizing files.


  If you use MPD, and want a graphical interface for it, Cantata should be on your short list of applications to try. Not least of all because it appears to be one of the few still being actively developed.


  Hugo-Reveal


  Reveal.js is a library for creating slideshow presentations using HTML, and is something I’ve used occasionally. Hugo is a static site generator I’ve adopted into my workflow. As such, I was pleasantly surprised when I discovered an article (link in Further Reading below) that covered a theme for Hugo that puts Reveal.js to good use. You can essentially turn your SSG (static site generator) into a presentation generator. The resulting static site can then be hosted almost anywhere you like (GitHub Pages, Netlify, your own host, locally, etc). I haven’t yet looked into the various options, nor have I tried to theme a presentation. However, if you’re looking for a relatively fast and easy way to get into Reveal.js (or just want a quicker alternative to something like Powerpoint or Good Slides), then I highly recommend giving this a shot. Using Markdown to format and style the slides is much faster than a typical GUI and mouse approach.


  
    [image: cc1]
  


  Laravel Homestead


  One of the video series I started watching was “Building SponsorShip” by Adam Wathan (one of the creators of Tailwind CSS), where he livestreams the process of developing a Laravel app with Tailwind CSS. The series is an excellent primer on using Laravel via TDD (test-driven development), and covers some aspects of Tailwind CSS as well. This prompted me to install Laravel on my computer myself. At first, I expected it to be as irritating to install and maintain alongside my other PHP applications as usual. Instead, I discovered that they offer Homestead - a prepared Vagrant virtual container for running and testing your projects. While it would be nice to have a lightweight option as well, Homestead is a very robust option. It may be possible to find a Docker container that also offers similar features, but the ease of installation and configuration for Homestead offsets the benefits of Docker.


  If you are looking to get into Laravel, I highly recommend you start with Homestead and work from there. If you happen to develop on macOS, they have a smaller option called Valet.
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  Test-Driven Development


  The video series mentioned above also drove home how useful test-driven development can be. While I’m no stranger to TDD, my main experience using it is with things like Exercism, where a set of tests are delivered to you and the actual application is what you need to write. I do occasionally write tests, but never for web applications when I work in Rails. I have therefore decided to take some time to learn at least the basics of TDD for Rails, Laravel, and Python in general. This will cover my 3 main languages, and should also allow me to discover the similarities between testing libraries.


  If you’re a new programmer - start with TDD as early as possible! I know this is a topic that frequently comes up when hiring new developers. It can also help you learn the “programmer’s mindset”. If you’re an experienced developer, you may have more trouble rewiring your workflow to include TDD, but it’s a step that most programmers should take. I don’t mean that TDD should be used for every project - if you’re writing 15 lines of code, you shouldn’t need to write tests for this. However, for any larger project, or project you may be maintaining for a while, TDD will pay off quite quickly.


  Notion


  Lastly - the most noteworthy application of all. A note-taking one! Notion is a web application that offers users the ability to take notes of any sort - to-do lists, bulleted lists, tables, databases, etc. It’s been one that I’ve had on my radar for quite a while (since Chris Coyier mentioned it on ShopTalk), but I waited until they had created an actual Android app. The web app lacked some features I required on mobile (such as notifications for reminders).


  Previously, I’d used Trello and/or Google Keep for tracking small notes. For anything larger, I’d open a google drive document. Now, I just open Notion and select the template that’s most suitable for what I need. For example, I use their Tasks template to create to-do lists similar to Trello (3 columns, and I move the items between them according to their status). You can also assign users to tasks.


  If you’re looking for a note-taking application that can do much more than just bulleted lists, I highly recommend you give Notion a shot. If you don’t feel like creating another account to keep track of, you can also simply use Google to log in.
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  Conclusion


  The above points have already (or will soon) shape how I work and organize myself. Hopefully, they can do the same for you! If any programmers among my readers have good suggestions for getting into TDD, please do let me know! As always, I can be reached under lswest34+fcm@gmail.com. I’m also open to article suggestions, questions, or comments!


  Further Reading


  
    	https://forestry.io/blog/harness-the-power-of-static-to-create-presentations/ - The article on using Reveal.js with Hugo.


    	https://youtu.be/NaTcbDbSPu4 - The first livestream for “Building SponsorShip” by Adam Wathan.


    	https://laravel.com/docs/5.6/homestead - Laravel Homestead documentation.

  


  
    Lucas has learned all he knows from repeatedly breaking his system, then having no other option but to discover how to fix it. You can email Lucas at: lswest34@gmail.com.
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  How To - Python in the REAL World - Part 85


  Written by Greg D. Walters


  When I meet another programmer for the first time, the first question that they usually ask is what languages do I program in. Their second question is usually what do I write my code in. Is it Emacs, VIM, a text editor, or an IDE. I surprise most programmers with my answer of Geany.


  One of the things that makes (and keeps) a programmer productive is an efficient IDE. Over the years, I’ve tried many different IDE applications and code editors, and I always come back to Geany. While Geany is not “officially” an IDE, it does the job, since it allows you to write code, and call a build process (for languages like C/C++).
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  It’s not flashy at first glance, but rather stark and bland. But once you start working with it, the lack of flashy is not a bad thing. With one exception, Geany has everything that a Python programmer (or most other programmers) would want. That one exception is debugging, which isn’t really that big of an issue for me.


  Let’s take a look at Geany in depth.


  Like any modern IDE, Geany has multiple editor tabs, which makes it easy to deal with most large projects. It also has support for split windows, either side-by-side or stacked.
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  This makes it very easy for me to see the definition of a function that I’m writing a call to, so that I know all of the parameters that I need to provide and in what order.


  One of the things that I like most about Geany is the ‘symbols’ sidebar.
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  This shows all of the functions that are in the current program, as well as the line number on which they are defined. Again, for me, this is a fantastic memory aid.


  Of course, Geany also has themes, from dark to light and pretty much anywhere in between, with over 30 different themes pre-defined. These are available as an add-on package.


  Another thing that many IDEs provide these days is snippet support, which are bits of preset code that can be inserted by typing a keyword and then pressing the 

  key. Here is an example of some of the predefined snippets…


  [Python]
utf8=#-*- coding: utf-8 -*-\n# vim:fileencoding=utf-8
for=for i in xrange(%cursor%):\n\t
doc=""" %cursor% """\n
elif=elif %cursor%:\n\t
else=else:\n\t%cursor%
if=if %cursor%:\n\t
from=from %cursor% import \n
main=if __name__ == '__main__':\n\t%cursor%



  So, if you wanted to start a for loop in Python, all you have to do is type:


  for



  …then hit the tab key (before typing the space after) and you get:


  for i in xrange(_):



  …with the cursor inside the parens waiting for you to flesh out the line. This works also with multiline blocks. Since I like to “decorate” my code with lots of comments, I set up one that I call ‘box’. When I use it, Geany puts in:


  # ======================================================
# _
# ======================================================



  I can just fill in the blank with whatever I need at the time.


  Of course, since Geany handles multiple programming languages, the snippets are language dependant, so you have to either save the file as a ‘.py’ file before you can use the snippet feature, or you can use the menu option Document|Set Filetype|Scripting Languages|Python source file.


  Keyboard shortcuts abound that take care of many of my work methods. As I’m programming away, sometimes I decide to add something that I wasn’t planning on when I did the original design. Many times, for example, I decide in midstream to add a Try|Except around a block of code. This requires the existing code to be indented. A simple 

  I indents the block and if I change my mind, a 

  U will unindent it. Commenting blocks of code is just as simple, using 

  E which will both comment and uncomment the code block.


  Another wonderful thing about Geany is that I can run my code directly from the Editor by clicking on the ‘Run’ icon, or by pressing 

  . By default, right now, I’ve got it set to use Python 2.x. If I want to run under Python 3.x, I simply use the Build menu options and select the option I’ve got set up for using Python 3. Again, many editors/IDEs allow for this.


  Yes, many of the better modern IDEs have most, if not all, of the features I’ve outlined here, but I find that Geany is easier to deploy them when I need them. Add the fact that Geany is Free, available for most operating systems, and is open source; I can be productive under whatever environment I’m using. Please take all of my comments as my own opinions and pertain to only my preferences.


  Until next time, have a great month.


  
    Greg Walters is a retired programmer living in Central Texas, USA. He has been a programmer since 1972 and, in his spare time, he is an author, amateur photographer, luthier, fair musician and a pretty darn good cook. He still is the owner of RainyDaySolutions, a consulting company, and he spends most of his time writing articles for FCM and tutorials. His website is www.thedesignatedgeek.xyz.
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  Freeplane - Part 6: Styles


  Written by Elmer Perry


  I’ve mentioned in past articles about developing a coding system for your mind maps. Implementing a coding system can seem like an arduous effort. But Freeplane allows you to create styles in your maps. Using styles, you create the style once and use it as often as needed. You can take a few minutes to think about and create the styles you need for your coding system of colors and icons. Once you make the styles, you select them from a dropdown list to apply them to the nodes.


  The Style Editor


  
    [image: free1]
  


  The style editor is where you create the styles. It looks like a scaled-down version of the main window. To open the editor through the menus, select Format > Manage styles > Edit styles. You can also use the keyboard shortcut CTRL + F11.


  Default Styles


  The default template comes with a set of default styles in 3 categories.


  Predefined Styles


  The predefined styles are the system styles. You can’t add to or delete any of the styles in this list. You can change the appearance of the styles:


  
    	Default is the style assigned to new nodes when not using an automatic layout.


    	Details is the styling for the node details.


    	Attributes are user-defined tags. I’ll explain attributes in a future article.


    	Note is the style for the note pop-up that shows when you hover over a node with notes.


    	Floating node is the style for any floating nodes.

  


  User Defined Styles


  The user defined styles are where you would add your own styles. You can add and remove styles from this list. The default template has a few styles defined for you. You can change these or remove them. The trick is to add new ones that work in your coding system.


  Apply Level Styles


  The level styles are a special group. You can automate the level styles by selecting one of the automatic layouts. The first level style is Root. You can change the Root style, but you cannot remove it. The Root is the center node of all maps. By default, you have 11 levels. You can add and remove levels as fits your needs. You can change the nodes to fit your coding system.


  Modifying Styles


  To change a style, select the style and use the tool panel on the right-hand side of the window. This panel is the same as the panel in the main program. You can set the colors, edge style, and even create a style with a cloud. The default floating node has a rectangular cloud around it. You can add icons to the styles as well. Open the icon toolbar by clicking on the sidebar arrow on the left side of the window. Or you can open it through the menus View > Controls > Icon toolbar. Click an icon to add it to the selected style.


  The display of the styles is a map itself, but you can’t create any children. You can add and remove siblings to the user styles and the level styles. The siblings are not added in the same way as in the main window – as detailed below.


  Adding Styles


  When adding a new user defined style, the style starts as a copy of an existing style. You can create a new user defined style from any of the styles, including the predefined and the levels. After selecting the style you want as your start point, use the menus Format > Manage styles > New style from selection. You can also right-click the style and select New style from selection. A dialog prompts you for a name for the new style. Enter the name and click the OK button. The new style will display in the User defined styles group.


  The level styles work a little differently. When you add a level, it adds to the end of the levels list. To add a new level, right-click any style and select Add level style. You can add levels through the menus at Format > Manage styles > Add level style. When you add a level by right-clicking, the format of the right-clicked style is not copied to the new level. New levels get the formatting of the default style.


  Remove Styles


  You can remove a user defined style that is no longer needed. Any nodes the style is applied to will have the formatting of the style removed. To remove a user defined style, right-click the style and select Remove user defined style. You can also remove a style by selecting it and using the menus Format > Manage styles > Remove user defined style.


  When you remove a level style, Freeplane removes the highest numbered level. As with the user defined styles, any nodes the style is applied to will have the style formatting removed. To remove a level style, use the menus Format > Manage styles > Remove level style. Or you can right-click any style and select Remove level style.


  Once you have finished changing the styles, click on the checkmark button to save your settings. If you want to exit the edit without saving your changes, click the X button.


  Applying Styles to Nodes


  The easiest way to apply a style is using the drop-down list on the main toolbar. The styles display in the same order as in the style editor. You can get the same list using the menus Format > Apply styles. After selecting the style, Freeplane applies the style to all selected nodes. If you select another style, you remove the current style and apply the selected style. It is possible to apply more than one style through conditional styles. I will cover conditional styles in my next article.


  Using level styles works a little differently. Level styles are applied by the node’s position on the branch. To apply level styles, use the menu Format > Automatic layout. You can apply the levels to all nodes by selecting for all nodes. Apply the levels to all nodes but the ones at the end by selecting for all non-leaf nodes. By default, disabled is selected. Disabled removes all level style formatting.


  Other Style Options


  Sometimes, you will change a node that has a style applied to it, and you want to apply those changes to the style. Use the menus Format > Manage styles > Redefine style. This adds the changes to the style and updates all nodes with the style. You can also use the keyboard shortcut ALT + R.


  At other times, you change a node and decide you want to revert back to the formatting of the style. Use the menus Format > Manage styles > Remove format to remove the changes.


  Did you create the best set of styles ever and want to use it in a new map? In the new map, use Format > Manage styles > Copy map style from… to import the style from another map. You can do this with the keyboard shortcut CTRL + SHIFT + O as well.


  Style Example


  
    [image: free2]
  


  When I create a map for brainstorming a writing project, I end up with list or outline. Sometimes, I get started but can’t get back to it for days or weeks. To keep track of where I’m at in the project, I create a TODO and Done style.


  The TODO style has a light red background and an empty checkbox icon. I apply this style to any sections that are not done. For the Done style, I apply a light green background and a checked checkbox icon. When a section is complete, I switch the style from TODO to Done.


  Styles allow you to design your coding system by creating a style once and using it many times. Through the use of styles, you can develop and change your coding system. Next time, I will show you how to create conditional styles that allow you to apply more than one style to a node. I will also show you how to save a template with all your styles, so you can use them over and over again.


  
    Elmer Perry is a technical support rep for an international keyless access company. He enjoys writing, woodworking, and technology. He lives in Leicester, NC with his wife.
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  HowTo - Encrypt Data With Cryptomator


  Written by John Bijnens


  When you copy data to a memory stick, and you lose the stick, your data can be read by anyone who happens to find it. When you place data in the cloud, your data can be read and analyzed for commercial purposes such as offering you tailored ads.


  The solution is to encrypt your data. This should be as hassle free as possible, and be independent of the operating system and platform you use – so you don’t have an excuse not to apply it.


  The software package that can fulfill all these requirements is Cryptomator. It takes only a few seconds to install it. It is written in Java. The latest version at the time of writing is 1.3.2. Users of Ubuntu (and derivatives like Linux Mint) can install it in either of two ways, namely by installing a deb package, or by installing it from a repository. As the latter allows for automatic updates, this way will be described in the remainder of this article. All examples are taken from a Linux Mint 18.3 Cinnamon installation.


  The first thing you need to do is to add the repository. Open a terminal window and type the following commands to add the repository and to install the software.


  sudo add-apt-repository ppa:sebastian-stenzel/cryptomator
sudo apt-get update
sudo apt-get install cryptomator



  This will also create a program icon as an easy way to start the software.
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  When you start Cryptomator, a dialog window appears that allows you to manage so-called vaults.


  In our example, we are going to store a folder ‘Secrets’ that is located within the folder ‘Documents’ in a new vault called ‘DemoVault’.


  Click on the + button to assign a new encrypted vault to a particular folder.


  
    [image: enc2]
  


  Then select the folder Secrets and enter the name DemoVault as can be seen in the following picture.
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  To conclude, you have to specify a password. The password may contain a mix of numbers and letters. An ideal password is a sentence and not a word. Don’t forget it as there is no recovery possible if you do. You can use a password manager such as KeePass2 if necessary.
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  You have now created your first vault. When you click on the button “More Options” you can specify that the vault will be mounted to the folder “DemoVault” and that this folder will be opened automatically (see picture below). To open it, click on the button “Unlock Vault”.
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  Depending on the configuration of your Linux system, you may or may not experience problems when writing/saving to an unlocked vault. The problems are caused by the way a webdav mount is handled by your Linux system. The developers of Cryptomator use gvfs to mount a webdav drive. This can cause problems on some systems. The solution is to use davfs. You can install it by opening a terminal window and typing


  sudo apt-get install davfs2



  After you’ve done that, you have to uncheck the option “Mount Drive”. Now you have to figure out what the webdav url is. Unlock the vault by entering your password. Click on the button next to “Lock Vault” and select the option “Copy WebDAV URL”.
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  Create a text document with the name ‘mount_vault.sh’ and enter the following 2 lines (the line starting with sudo is one line).


  #!/bin/bash
sudo mount -t davfs http://localhost:42427/2BerFJngQY2v/DemoVault /home/john/Documents/Personal/DemoVault -o username=john,rw,uid=john,gid=john,file_mode=700,dir_mode=700



  Notes:


  
    	http://localhost:42427/2BerFJngQY2v/DemoVault (This is yourWebDAV URL)


    	/home/john/Documents/Personal/DemoVault (This is an existing folder you want to mount the vault to)

  


  Similarly, create a text document with the name ‘umount_vault.sh’ and enter the following 2 lines (the line starting with sudo is one line).


  #!/bin/bash
sudo umount /home/john/Documents/Personal/DemoVault



  Now you have to make the two files executable by issuing the commands:


  chmod u+x ./mount_vault.sh
chmod u+x ./umount_vault.sh



  Now you can use ./mount_vault.sh to mount your vault after you have unlocked it, and use ./umount_vault.sh to unmount it again. After that you just have to lock it. For the time being this is a workaround for the mount problem on systems that have problems using gvfs.


  Cryptomator is free and open source. If you like it, and want to support its development, you can donate some money on their website. This way, the developers know their hard work is appreciated.
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  How To - Drawing with Inkscape – Part 75


  Written by Mark Crutch


  Having looked at the four main ways of including an SVG file in a web page, we’re going to start examining what you can actually do with SVG files that you can’t achieve with simple raster graphics.


  Speaking of simple raster graphics, that’s the first of our four ways of including an image, and it’s one that I’m going to dismiss immediately. Once you convert your SVG to a raster graphic, be it a png, jpeg, or gif, it becomes no different in capability to a photo from a digital camera. You can display it in your web page, but that’s about it. Sure, with modern CSS and JavaScript you can make it respond to mouse events, and can use some SVG-style techniques such as masking, clipping and (basic) filtering – but none of those abilities come from the image itself. Your raster image is essentially a rectangle that can only be modified as a single entity, losing all notion of the individual objects in your original SVG file.


  So let’s move on to the second way of including an image: by linking directly to the SVG file. For this example, we’re going to use the following simple HTML page, which just contains a link to our SVG file in an <img> tag:


  <!DOCTYPE html>

<html>
<head>
  <title>SVG in HTML</title>
</head>

<body>
  <img src="square.svg"></img>
</body>
</html>



  As for the SVG file, it’s just a simple square, drawn in Inkscape, and centered in a square page.


  
    [image: ink1]
  


  I’m going to wade in and add some handwritten CSS to this file, so, for the sake of clarity (not to mention space), I’ve saved the image as an Optimized SVG. Everything I’m going to do would also work on an Inkscape SVG, but if you’re not familiar with editing XML files, it’s probably worth using optimized files, at least at first, so that you don’t have a load of extra elements and namespaces getting in the way. My optimized file looks like this (with a few line breaks added for clarity – they won’t affect the image):


  <svg width="360" height="360"
  version="1.1"
  viewBox="0 0 95 95"
  xmlns="http://www.w3.org/2000/svg">

  <g transform="translate(-7.6 -5.2)">
    <rect x="29" y="27"
      width="53" height="53"
      style="color:#000000;fill:#f00;
        paint-order:stroke fill markers;
        stroke-width:8;stroke:#800000"/>
  </g>
</svg>



  A hand-coded version of this image could be even smaller – there would be no need for a 

  with a transform when the x and y coordinates of the 

  could be adjusted directly. But this is, after all, an Inkscape column, so I’ll work with the output it gives me.


  With my SVG file created and saved into the same directory as the HTML document, loading the latter into a web browser gives exactly the result you would expect: a web page with a square in it. So far, we haven’t really gained a lot over using a bitmap. Yes, technically it retains a better quality when scaled, and SVG files are often (though not always) smaller than their raster equivalents – but in many cases those are modest benefits at best.


  But, even when used in an <img>, there are some things we can do with an SVG file that can’t be done with a raster image. Unlike a raster image, an SVG file can include its own CSS code. Let’s begin by making our red square blue (note, I’ve abbreviated the <svg> element for space – in practice the file still contains the full element from the previous example):


  <svg ...>
  <style>
  rect { fill: #00f; }
  </style>

  <g transform="translate(-7.6 -5.2)">
    <rect x="29" y="27"
      width="53" height="53"
      style="color:#000000;fill:#f00;
        paint-order:stroke fill markers;
        stroke-width:8;stroke:#800000"/>
  </g>
</svg>



  If you’re not familiar with CSS, then here’s what we’ve done: first there’s a pair of opening and closing <style> elements. The CSS code will be held within them. The CSS code itself consists of a selector that identifies what element(s) in a page the rules should apply to. In this case we’ve used a simple element selector: essentially if you just use the name of an element (in this case “rect”), the rules will apply to every instance of that element. As we’ve only got one <rect>in our file, we know that the rule won’t accidentally affect anything else.


  After the selector come the rules, in a block between a pair of braces (the “{” and “}” characters). We’ve got only one rule at the moment: to make the fill blue (using hexadecimal RGB syntax for the color). So, let’s reload the page and take a look at our…
 …red square.


  As you may already know, CSS stands for “Cascading Style Sheets”, and it’s the “cascading” part that has interfered with our plans. Without going into all the gory details, it’s possible to have more than one source of CSS rules affecting an element, and the details of the cascade dictate which rule will take precedence over the others. In almost all cases, if there’s a rule directly placed on an element using a “style” attribute, that will win. So, in our case, if we just remove the “fill:#f00;” from within the style attribute of the <rect>, the rule we’ve added to the <style> block will win instead. This time if we reload the page… our square is blue.
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  That’s all well and good, but so far we haven’t really achieved anything that couldn’t have been done just by drawing a blue square in the first place. But what we have done is to move the rule that governs the color of the square from the <rect>element (where we can’t easily override it) to a separate block of CSS (where we can). Our options for how to override it, however, are rather limited. This is just an image in our web page, so mouse events aren’t propagated into the file itself. That means no color changes on clicks, or on hovering the mouse over the image. In fact there’s really only one thing we can do to modify the image in this situation: animate. And that requires more CSS.


  To begin with, we have to expand our existing set of rules to also include some information about the animation we want to use. At a minimum we have to create a name for the animation (so that you can have more than one in a file), and tell it how long the animation should last. That means our rect selector now looks like this:


  rect {
  fill: #00f;
  animation-name: myAnimation;
  animation-duration: 3s;
}



  The choice of animation name is up to you, but it has to match whatever name you use in the next section. This is where we define the keyframes – specific points in the animation when we set the values the CSS should take. Here’s a simple example for animating the fill from red to blue:


  @keyframes myAnimation {
  0% { fill: #f00; }
  100% { fill: #00f; }
}



  The syntax is pretty straightforward. First we start with the string “@keyframes” to indicate that this is a set of keyframes, followed immediately by the name we defined earlier. Then, inside a block of code between braces, we have individual entries for each keyframe.


  A keyframe entry is just the same as any normal block of CSS, except that the selector is replaced with a percentage, representing how far through the animation this block should apply. You pretty much always need at least a block for the start of the animation (0%) and one for the end (100%), but you can add more in-between if you want. Because animations with just two keyframes are so common, you can also use the words “from” and “to” instead of 0% and 100%, which arguably makes the code a little more readable.


  So, taking both of the blocks above together, we’ve essentially said “create a set of keyframes called ‘myAnimation’ and run them on the <rect> over a period of 3s. At the start the fill color should be #f00 (red), at the end it should be #00f (blue).”


  There’s one little caveat to catch: notice that there’s still a fill value on the rect CSS block. At the end of the animation, the “normal” CSS for the element will kick in, so if we don’t also make it blue in there, the fill will change to black. Sometimes that behaviour is desirable; you want to change the style back to the defaults after the animation has run. But, more commonly, you want the style at the end of the animation to persist.


  As an alternative to duplicating the final rules for the element, we can make the last style stick by adding the “animation-fill-mode” rule to our rect block instead. The behaviour we’re seeing is equivalent to setting this to “none”, but you can also use “forwards” to make the element continue using the style from the last keyframe. There’s also “backwards” which does the same with the first keyframe for animations played in reverse, or “both” which works in either direction, and is usually the simplest option to choose.


  Animations played in reverse? Yes, there’s another property that will let you do that: “animation-direction”. The default value is “normal” (i.e. your animation plays forwards from 0% to 100%), but you can also set it to “reverse” (100% to 0%), “alternate” (0% to 100% then back to 0%) or “alternate-reverse” (100% to 0% then back to 100%).


  Once you’ve decided what direction(s) your animation should run in, you might want to also determine how many times it will be performed. For that we have “animation-iteration-count” which can take the value “infinite” to make the animation run forever, or a number – to specify a particular number of cycles. Note that a single cycle goes from 0% to 100% (or vice versa), so if you set “animation-direction” to “alternate” or “alternate-reverse”, you’ll need to set the count to 2 rather than 1 to display both halves of the animation. With these values, any odd number will finish at the end of the animation, whilst an even number will return you to the start. This is also why it’s usually worth setting “animation-fill-mode” to “both” – you can then change the animation count without having to worry about a sudden change in style, regardless of whether there are an odd or even number of cycles.


  Let’s put all this together, and add another keyframe for good measure. I’ve also thrown in an “animation-delay” so that there’s a short pause between the file loading and the animation starting. Our <style> block now looks something like this:


  <style>
  rect {
    animation-name: myAnimation;
    animation-duration: 3s;
    animation-fill-mode: both;
    animation-direction: alternate;
    animation-iteration-count: 3;
    animation-delay: 2s;
  }

  @keyframes myAnimation {
    0% { fill: #f00; }
    50% {fill: purple; }
    100% { fill: #00f; }
  }
  </style>



  So far, we’ve animated only one property at a time. But because each keyframe carries a block of CSS, it’s possible to animate more than one property on an object. Here I’ve also animated the stroke color and width to substantially change my square over the course of the animation:


  @keyframes myAnimation {
    0% {
      fill: #f00;
      stroke: #800;
      stroke-width: 8;
    }

    50% {
      fill: purple;
      stroke: #f00;
      stroke-width: 16;
    }

    100% {
      fill: #00f;
      stroke: #008;
      stroke-width: 40;
    }
  }



  The result, captured at 2s (the length of the delay, just as the animation starts), 3.5s (halfway through the animation), and 5s (the end of the animation), looks something like this – though, obviously, the real thing isn’t a series of three images, but a single image that transitions through these three states:


  
    [image: ink3]
  


  In practice, the iteration count of 3 and direction of “alternate” means that, after a 2s delay, the square progresses through each of these states (iteration 1), then back again in the opposite direction (iteration 2), then finally through them in order again (iteration 3). At the end of the animation the square remains blue with a thick stroke, due to the presence of animation-fill-mode: both.


  As you can see, animating an SVG image allows for possibilities that aren’t really available with raster images – at least not in a high quality way that works on most browsers. Next time, we’ll expand on these capabilities to push our SVG animations even further.


  
    Mark uses Inkscape to create three webcomics, ‘The Greys’, ‘Monsters, Inked’ and ‘Elvie’, which can all be found at http://www.peppertop.com/
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  Researching with Linux: R-Studio and Gnuplot in Action Chapter 1


  Written by S. J. Webb


  I have a dedicated R program for processing data. So, I have downloaded R, and the associated R-studio for my work laptop. The R-studio is a GUI interface for R and is divided into 4 panes. The upper left is the R program that you can import from Leafpad. The lower left is the actual real-time command-line processing. The upper right is publishing the rights for the statistical outputs and tables for journal abstracts. The lower right is the produced tables.


  R has the capability of creating a Shiny app which is an online capability for the R programs that you use. It is now possible to be connected to your R programs using a web browser. The Shiny app replaces a previous Perl Batch program. The batch program required 2 hrs, the Shiny app does the same amount of work in 20 minutes.
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  The Shiny app then generates a pdf of the waveform plots (as seen in the lower right) and the associated critical points. The Shiny app works well, but there are a few “bugs” in the R-code written by my biostatistician so the app is not perfect; however it saves time and removes technician bias in data processing. Yet it does a great job of generating the data spreadsheets for the pressure and motion data sets needed. An example spreadsheet below.
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  Onto gnuplot now.
 I read the starting pages on a rather dry subject: statistics. There are 2 software developers’ forewords, an ‘about this book’, 15 chapters, and an appendix. The starting paragraphs have important background and historical information on Gnuplot. Yet it does not cover the real story. I jumped into Chapter 1, and it is quite light with a 15 page span.


  Luckily, Gnuplot is part of the RPM and Debian repositories. I changed to root and installed gnuplot via terminal – which was an incredibly smooth process. I searched the menus and did not see an app icon. I rebooted, right-clicked, and launched terminal with gnuplot. My book is written about Gnuplot 4.0, not 5.0. I am banking on the idea that gnuplot is relatively static and that the commands are reliable.
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  Chapter 1 merely reviews the scope and capabilities of Gnuplot. It a simple 15 pages that goes into a brief description of commands. The authors use an example of planning a morning marathon and staffing issues. Essentially, it was attempting to use bimodal statistics to highlight a need that there were two surges of marathon runners: professionals and amateurs. The staff would needed to be present at early start, say 10am, then 11am and 1pm. The professionals would end at 11 am while the amateurs will be 1 pm. Staffing would be heavy at those times. This chapter ends by stating that each chapter will treat the reader as a new user. I believe the final message is that gnuplot will “illuminate” the truth found in statistical data.


  
    S J Webb is a researcher coordinator. When he is not working, he enjoys time with his wife and kids. He thanks Mike Ferarri for his mentorship.
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  Everyday Ubuntu - Updating and Upgrading Applications and the Linux OS


  Written by Richard Adams


  In order to stay up-to-date on Linux, you will need to update, and may opt to upgrade when major releases occur. You will probably also want to periodically update your applications. This month, we’ll be looking at how to do these essential maintenance functions.


  Routine updates are handled through the Software Updater, which you can find in the Dash, or use the HUD – Heads-Up Display:


  
    	The Dash is launched by clicking the Ubuntu wheel icon (first on the Launcher).


    	The HUD can be invoked by pressing the ALT key on the keyboard.

  


  Either way, do a search (‘UPD’ will probably be more than sufficient) and find the Software Updater (or, do it the hard, but admittedly more intuitive, way, and go to the Dash, click A at the bottom for Applications, click Installed, then scroll down to Software Updater):
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  The Updater will look for updates in whatever repositories you have configured (for more on repositories, see Everyday Ubuntu in FCM #130). Once it completes, it shows you a list of found updates. You will probably want to accept all, but you can uncheck any as desired:
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  You will have to authenticate with your SuperUser, or administrative, credentials:
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  The Software Updater will then start downloading the available updates:
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  You can also update through the command-line tool Apt-Get (see more, also in FCM #130’s Everyday Ubuntu column). In this instance, launch the Terminal and the command will be:


  sudo apt-get update 


  Sudo, remember, is SuperUser DO, used to allow a ‘normal’ user to temporarily act as an administrator, or ‘SuperUser’. You may want to get a shirt with a big red ‘S’ on it for the times when you feel like a Super User, not that I would EVER do anything that silly…. Anyway, the ‘apt-get update’ does just what it looks like: installs updates. You can also use apt-get with a ‘-f’ at the end to tell apt-get to ‘fix’ any broken applications:


  sudo apt-get -f install 


  (This command may remove partially installed or broken applications, so beware.)


  You may find yourself wanting to upgrade to the shiny new version of Ubuntu from time to time, and that is a lot easier than it used to be. Click on the Gear icon on the top-right of your screen and go to System Settings, then click Software and Updates. Click the Updates tab. If the option for ‘Notify me of a new Ubuntu version’ (at the bottom) is set to anything but ‘for any new version’, change it to just that, ‘for any new version’. Close and the Software Updater should pop up a message if a version is available that’s newer than the one you are currently using. Click ‘Upgrade’ to start the in-place upgrade process, then go make a sandwich while you wait to get the shiny new Ubuntu Astonishing Anteater, or Spectacular Spider-Monkey, or whatever Adjective Animal it is this go-round. After a while, you’ll be back in business, but with whatever new features Canonical blessed us with in the newest release.


  Sometimes the Software Updater won’t find or acknowledge the available upgrades, but not to fear – the Command-Line can come to our rescue once more. Go to a Terminal window and type in:


  sudo apt-get upgrades 


  then type in your credentials and the upgrade should start downloading and installing.


  APT-GET Revisited


  Everyday Ubuntu correspondent Marc Grossé, from France, offers an interesting tip on using APT-GET: You can concatenate multiple arguments after the ‘install’ switch. Marc uses this as a way to easily reinstall multiple applications with a single command when reinstalling Linux or installing it on a new machine. You can open the Linux text editor and type in the following:


  sudo apt-get install njam synaptic burgerspace dosbox 


  replacing the string ‘njam synaptic burgerspace dosbox’ with a list of the applications you use, with spaces between each. Save the file. Then, when ready to reinstall all at once, open the text editor again, highlight the text, and go to Edit – Copy. Now open the Terminal and use Edit – Paste to put the string in. Hit ENTER and Linux will start installing the applications without having to type the ‘sudo apt-get install’ part repeatedly. Save the file as a text file and you can put it on a removable media drive and transfer it for use on a newly set up machine, as well. Thanks to Marc for a handy time-saving tip!


  Next time: Getting to know the Dash.


  I invite feedback on easier/better ways to do things. Any such submissions in response to articles or content will be considered the property of Full Circle Magazine for publication purposes, without remuneration, unless the writer/commenter specifies otherwise. That said, commentary and feedback are heartily encouraged and appreciated, at acer11kubuntu@gmail.com.


  
    Richard ‘Flash’ Adams has been a Linux or Unix user for 25 years. He lives in rural north Georgia, USA, with his cockatiel, Baby, who does not talk, but is a very talented whistler.
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  Ubuntu Touch Update: Formalizing the UBports Foundation


  By UBports Marketing Team


  
    The final steps to become an official foundation
  


  April 2017, the UBports Community took full responsibility for the development and maintenance of the Ubuntu Touch mobile operating system. This has led to huge growth of the community. In order to fulfill the growing needs of the community, and support the ambition of sustaining healthy development of Ubuntu Touch and its ecosystem, a formal and legal entity, with proper leadership, would be necessary. And so, efforts to create a Foundation began. As we stand today, approximately one year later, we’re still moving ahead, and are already on the final steps of the long legal/bureaucratic process for the setup of the UBports Foundation. All the paperwork has been submitted, and we patiently await the decision of the authorities.


  Ubuntu Touch is built by the community for everybody who values freedom of choice. Forming an official Foundation has been a long-time goal for UBports. We are getting very close to this goal; we expect to have the formal UBports Foundation established in August/September 2018.


  A bit of history


  The idea to create a foundation evolved over time. We’d like to shine some light on the history of the project and involvement of the UBports structure.


  The Beginning
 In 2015, Marius Gripsgård got an itch; he felt that the Ubuntu Touch project (at that time maintained and developed by Canonical) should be available to everybody. So he forced himself to start porting the OS to a “secret device”. During this period he had first contact with some interested sponsors. Not much later UBports was born.


  Joint Forces
 In November 2016, at Ubucon – Essen, the project became more serious. Marius presented his plans to a bigger audience and managed to persuade a sponsor to make financial resources available with the aim of establishing a Foundation. However, the time was not right to take that step. Ubuntu Touch was still supported and developed by Canonical.
 A couple of months later, a team, including Marius, was invited to join Canonical at Mobile World Congress 2017. From this moment, the dream was ignited! We were ready to join forces and figure out how to move forward with porting Ubuntu to the mobile devices.


  A Bomb Drop and a New Starting Point
 Not much later, Canonical dropped some shocking news. In April 2017, they announced that they would no longer be developing Ubuntu Touch or Unity 8 - its “phone and convergence shell”. Unity 8 was central to Canonical’s efforts to have one user interface across all devices. At that time, a small group of contributors started to explore the opportunity of restarting the development of Ubuntu on the mobile devices. UBports made its first steps and prepared to “fork” Ubuntu Touch. As you all know now, the brand Ubuntu Touch has seen the light, and, as of today, it is still called Ubuntu Touch.


  Operating as the UBports Community


  Since the UBports community took over the full development of Ubuntu Touch, new steps needed to follow. In order for UBports to reach its full potential, there was (and still is) the belief that the establishment of an official legal Foundation would be required to maintain the interests of the community.


  Jan Sprinz and Ewald Pierre took upon themselves the task of preparing the required documents and Foundation structure. To do this correctly, a first visit to an accountant took place on June 28th, 2017. On the side, lawyers took care of the legal documentation, including laying out the correct usage of the brand (logo, name, distinctive marks, etc…) and finalizing the Foundation documents. When requested, an experienced partner (LibreOffice) helped us out.


  Meanwhile the community behind Ubuntu Touch grew fast. New sponsors committed themselves to the project and UBports transformed into a well structured group with a current member count of well over 1600 people.


  Formalizing the UBports Foundation


  The UBports Board of Directors (BoD) is excited to announce that UBports has officially sent (June 19th, 2018) her formal request for approval to the local government in Berlin. We are proud that the final steps to become an official Foundation are now completed and we expect to have the formal UBports Foundation established by August/September. A Foundation provides the project benefits such as more structure, and new funding and merchandising opportunities.


  
    We need your help to be successful: join the project, and be part of the excitement.
  


  Ubuntu Touch is moving forward. The operating system developments are getting closer and closer to the very important big release(16.04) as well. The first release candidate was launched a couple of weeks ago. If you’re interested in the development of Ubuntu Touch, learn more about it, and about the UBports Community, at www.ubports.com.


  Built on respect, enthusiasm, and diversity, UBports is a community in which all members are highly appreciated and welcome to contribute. There is always a place to contribute in one of the foundations’ Steering Committees (SC) or Focus Groups. Besides challenging technical issues, there are many non-technical opportunities for your contribution as well. We can use all the support we can get to help make the new Foundation more efficient and successful. Whatever set of skills you have, you are very welcome to become part of our community!
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  Explore the opportunities at http://ubports.com/r/scH/m/68
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  My Story - Part 5


  Written by Paolo Pelloni


  Quick recap so far. I wrote a program to enter sort information in Rhythmbox in an easier way than to do it manually track by track. I did it to solve a need, fix something Rhythmbox wasn’t doing in the way I wanted it, and also to brush up my programming skills, learning Python along the way. Satisfied with that, I decided that the next step was try to enhance it.


  The program you saw last month, does what is says on the tin, but it’s cumbersome – to be generous. It runs from the not-so-friendly command line, and can handle only one album at a time. I wanted therefore to write a graphical interface on top of it and, while I was at it, start using a better IDE.


  What is an IDE? It stands for Integrated Development Environment (more info at: https://en.wikipedia.org/wiki/Integrated_development_environment). So far, I used separate tools, well, actually only one: gnome text editor. It was my source editor of choice, simple, efficient, and it has code color coding. See Illustration 1 for how the code of fixrhy looks in gedit; note that it automatically recognises the language!


  A graphical application was expected to be more complex, so I wanted an environment that also had auto-completion, code folding, and more sophistication. The only IDE I knew was Eclipse, very powerful but a tad too much for my requirements. I headed off to Ubuntu Software Center and searched for IDE. I was overwhelmed by the number of results – open source; it’s a great world! I decided to refine my query: “IDE Python”. I opted to try Geany and installed it right away (you can also install it with the command: sudo apt install geany). If you decide to try this lightweight IDE, I suggest you check the plugins, there are several of them, and some may be useful for you (see Illustration 2). Check Illustration 3 for a glimpse of the Geany editor window.


  With Geany, I could write my code and test it without leaving the editor. There are several ways of launching the application: pressing F5, or clicking on Execute under Build, or using the relative icon on the toolbar. It’s a simple shortcut, but it speeds up development when you want to immediately check your last source code change.


  When you develop graphical applications in Ubuntu (or Linux for that matter), you can leverage existing libraries and environments: probably the two most common are QT and GTK+. I opted for the latter and consequently I named the new application fixrhygtk. The last bit I had to work on was how to design the user interface of the application. I had a choice between coding it from scratch, or use a tool, and the tool option was the preferable. I had no need for lean code or speed, so why bother wasting time writing many lines just to describe a button in a window, when a tool like Glade could do it for me? You can check it at https://glade.gnome.org/. In a nutshell, Glade is a visual editor where you can design your user interface (windows, dialog boxes, menus, etc…) on the screen using your mouse like a drawing application. When you have finished the process, you can save an XML file that can be loaded into your application, and, from there, with few lines of code, display your objects on the screen and interact with them. Installing Glade is as easy as Geany, you can search for it in the Ubuntu Software Center (soon to be replaced by Gnome Center) or do it via the command-line with sudo apt install glade.


  Before getting into the actual code (we’ll examine it in the next issue), I would like to point out two things. First I had to do some research to understand the basic structure of a Python GTK+ application. If you search Google with these keywords, there are loads of results and I encourage you to check some “Hello world” programs to familiarise yourself with a basic backbone. You probably want to understand also how containers play a role in the graphical layout of a GTK+ application. For me, the Python GTK+ 3 Tutorial acted as an introduction to some concepts, and also as a reference guide later on when I was writing code. You can find it here: http://python-gtk-3-tutorial.readthedocs.io/en/latest/basics.html For me, it was important to read the introductions to chapters 2, 3, 5, 20, 21 and 22.


  While I was doing my prework, I realised that it was easier for me to write a complete standalone program, using the knowledge I got from coding fixrhy, rather than writing a GUI interface that would use the CLI program to execute the changes. If I had to change 7 different albums, with the CLI version I had to run it 7 times and therefore parse the DB 7 times. That is not efficient; I could have amended fixrhy to accept multiple albums, but that would have been too much work. Easier to do all the processing inside the application, as we are going to see next time.
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  How To - Write For Full Circle Magazine


  Written by Ronnie Tucker


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.


  The Official Full Circle Style Guide can be read at: http://bit.ly/fcmwriting


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression. When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don’t worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we’ll help you with your English!


  FOR REVIEWS:


  Games/Applications When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary – with positive and negative points

  


  Hardware When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary – with positive and negative points

  


  
    You don’t need to be an expert to write an article –write about the games, applications and hardware that you use every day.
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  Review - nnn


  Written by EriktheUnready


  If you use the terminal often, or use a tiling window manager, you may have heard of Noice.


  Noice is Not Noice, a noicer fork.


  From the Reame.md (version: 1.7.1):
 nnn is probably the fastest and most resource-sensitive (with all its capabilities) file browser you have ever used. It’s extremely flexible too - integrates with your DE and favourite GUI utilities, works with the desktop opener, supports bookmarks, has smart navigation shortcuts, navigate-as-you-type mode, disk usage analyzer mode, comprehensive file details, and much more. nnn was initially forked from noice but is significantly different today.


  In Ubuntu nnn is simply installed with:


  sudo apt install nnn


  No PPA’s to add or anything.


  To run nnn, fire up a terminal window or move to a terminal TTY to use.


  The claim about resource usage is true, nnn does not even register on the radar.


  
    [image: review1]
  


  The first time you run nnn, you immediately know what is going on. To exit, simply press q.
 The only thing missing is how to drive this thing:


  
    	The up / down / left / right arrow keys steer.


    	Home and End do just that.


    	To open a file or folder, hit Enter, or, to go back, press Backspace.


    	Need to go to your home folder: Tilde (~), the same as bash.


    	If you need to create a new file or folder, press n.


    	Did you make a mistake? Rename it with CTRL+r.


    	Need to see hidden files, press the full stop or period key (.).


    	TIP: if you need help steering, at any point press the (?) question mark, and q to exit the help.

  


  There is no Vi funnies here. We can say nnn is intuitive.


  Let’s look at some of the more impressive and useful functions:


  
    	nnn has the ability to bookmark a spot. If you work in a directory often, why not bookmark it? It is a simple as, you guessed it, b. To head to your bookmarked folder, hit CTRL+v.


    	If you require more detail about a file, the key is d. You can just press the d key again to exit the detailed view. This is also very handy if the file name is too long for your display.


    	Should you require details about the file, say an mp3, where the bitrate or file permissions are important, you use a capital D. To quit this view , hit q.


    	While we are on mp3 files, there is one caveat, nnn is designed to integrate into your desktop. Hitting the right arrow or enter will not open MOC if it is installed. It will open the default player set in Ubuntu.


    	If you have a lot of files and would like to see the size of each, press capital S.


    	Lower case s will sort your files from largest to smallest or with another press, smallest to largest.


    	Do you need a shell in the current folder? Simply press (!) exclamation (or pling, or bang, as it is known).


    	There are commands that do not work out of the box, o will do nothing until you tell it to open your file manager. By exporting your environment variables you can set the defaults, eg: export NNN_DE_FILE_MANAGER=nautilus - Now nautilus will open in the folder where you are when you press o.


    	The e key is the pest and will open vi as your default editor, not nano. Not that Vi is bad, but it is not newbie friendly.


    	The r key likewise. That said… It is configurable! Export your environment variable and it will be so!

  


  Full speed ahead, Mr. Sulu. nnn can make your terminal experience a whole lot easier and speedier. I do recommend you look at the nnn man page, as it is one of the better man pages.


  Pro’s:


  
    	Fast


    	Intuitive


    	Integrates well with any DE

  


  Cons:


  
    	There may be some setup work required.

  


  Overall, nnn is very useful, easily customizable, and a pleasure to use. I cannot find any faults and find it invaluable to navigate web server content folders when you only have a terminal. I would definitely recommend this to anyone using the terminal.
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  Letters


  Compiled by Ronnie Tucker


  
    If you would like to submit a letter for publication, compliment or complaint, please email it to: letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.
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  Q&A


  Compiled by Erik


  
    If you have a Linux question, email it to: misc@fullcirclemagazine.org , and Erik will answer them in a future issue. Please include as much information as you can about your query.
  


  Hello FCM readers. When Ronnie asked me if I would take over the Q&A, I thought: “sure, we’ve got TONS of questions and answers”. Then I looked in the database. Technicians are strange creatures to say the least. Writing what you did a day after the fact can make you forget what you did. This is when their creative juices start flowing. I will start off with some humorous ones, before we get to the serious stuff.


  


    	Q: Whenever I put in my password into Ubuntu, it usually fails and I am sure I am typing it correctly. It takes me several tries every time.


    	A: Customer is in hospital after accident and has his laptop on his chest. When his right arm reaches over to type on the left side of the keyboard, to type 123, his forearm brushes the Enter key on the numeric keypad.


    	Q: The new Ubuntu 18.04 dock does not minimize or maximize my window.


    	A: The “dock” is actually a favourites bar. You can remove it by: 

    
      	Installing gnome tweaks.


      	Installing the dash to dock extension from https://extensions.gnome.org/extension/307/dash-to-dock/


      	Under extensions, turn off Ubuntu dock.


      	use ctrl+alt+t to open a terminal and type:
 sudo apt install docky or sudo apt install plank

    



    	Q: I don’t like the Ubuntu 18.04 look, how can I enable fallback like on previous versions.


    	A: Open a terminal and type: 

    sudo apt update
sudo apt install gnome-session-flashback



    When you log in, click the gear icon next to “sign in” and select “GnomeFlashback” before clicking sign in.



    	Q: After installing DNScrypt in Ubuntu 18.04 and rebooting, I cannot access the internet.


    	A: Manually, set your DNS by opening the settings application, WiFi, and click the gear icon next to your network name. Click on IP4 and turn OFF automatic DNS. Insert a DNS server in the provided space. Now click apply. it should work immediately.


    	Q: Gnome is not working for me. How can I get Unity back.


    	A: Open your terminal and type: 

    sudo apt install ubuntu-unity-desktop



    At the prompt, select lightdm


    Reboot



    Click the gear icon next to sign in, and select “Unity” before logging in.



    	Q: Any idea why, if I have XRDP installed on my Raspberry Pi, I just get a blank screen when I remote in from Win 10?


    	A: This seems to be a common problem, with the forums suggesting one uses Tiger VNC. Using Real VNC, https://www.realvnc.com/en/connect/download/viewer/linux/ the VNC part works. 

    Anyway it’s working. I’ll consider switching VNC servers to XRDP later.



    	Q: I have set up a new server, using an SSH key that I generated via PuTTyGen, and I created my server using the public key. When I try to connect using PuTTy, and including my private key, I get the error: Server refused key


    	A: Copy and paste the key from PuTTyGen, do not use the contents of the public key file.


    Featured questions at askubuntu.


    	Q: Installing Ubuntu 18.04 dual booting with windows 10, connecting to the wireless is pretty slow. The wifi card is a Broadcom BCM4313 802.11bgn wireless network adapter.


    	A: Under software and updates, select Additional drivers and install the proprietary Broadcom driver. 

    https://askubuntu.com/questions/1001351/uuid-xxx-does-not-exist-dropping-to-a-shell



    	Q: I have an Elementary OS installation on a Dell Optiplex 790. When I move it to my new Dell Optiplex 990, I get ALERT! UUID=dd53f4a2-d5af-87c8-9b3e-eb074a7849fbf does not exist. Dropping to a shell.


    	A: BIOS setup is very important. UEFI and Legacy boot is not compatible. Dell Bios is in “Raid on” by default.


    	Q: I can’t find any documentation on installing and configuring codeigniter on ubuntu 16.04. Any help would be appreciated.


    	A: Please see: https://www.linuxhelp.com/how-to-install-codeigniter-in-ubuntu/


    	Q: How to make sftp user not have access to hidden files?
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    	A: Use chown and chmod just like with any other file.


    	Q: I’ve been having problems all day, with sites going down.
 I am using PUTTY on Windows to access the server.


    To update I use:


    sudo apt-get update && sudo apt-get dist-upgrade



    Seems to work. Could someone tell me what’s next?


    I think I need to reboot the server or apache but it keeps not working. Putty keeps dumping me out and/or the sites are still down.


    	A: After doing an upgrade that installs a new kernel version, a reboot is required for the new kernel to be loaded. You can do this from PuTTY with sudo reboot. It is expected that this will kick you out of PuTTY since there will not be a server on the other end of the connection during the reboot. 

    Once rebooted, if your sites are not up, you can try manually starting Apache with:


    sudo service apache2 start



    If the service fails to start, check the Apache error log file in /var/log/apache2/error.log where details of any errors encountered when trying to start the service will be recorded.



    	Q: Trying to set up Nginx in Ubuntu 16.04 from tutorial, everything is fine but running the command:


    sudo ufw status



    gives inactive. What is wrong?


    	A: sudo ufw enable


    	Q: I would like to know the steps to install Mariadb, Please don’t say ‘use mySQL’.


    	A: 
 

    sudo apt install mariadb-server



    	Q: Can anybody explain how do I check web request logs on Ubuntu server with wordpress running on Apache?


    	A: error log files can be found at: 

    /var/log/apache2/access.log and /var/log/apache2/error.log with Apache


  


  
    Erik has been in the IT industry for the last 30 years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable to scaling 3G towers, he has done it. He thinks open source is the way forward.
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  Ubuntu Games - Warcraft III - Part 2


  Written by Oscar Rivera


  Continuing with Warcraft III from last month, where we covered how to install it and how to run it on Ubuntu 18.04, this month we’ll review the actual game. As stated last month, please remember that, to launch the game, you must first type the following (as a single line/command) in a terminal:


  wine ~/.wine/drive_c/Program\ Files\ (x86)/Warcraft\ III/War3.exe -opengl -nativefullscreen


  If you forget to run the previous command, it’s basically impossible to get the game going (the game might start, but then, when you select the mission you want to play, the game will crash).


  Once you get the game running, it’s a pretty cool game to play. So far, I’ve been able to play the game for many hours without any issues. The game plays pretty smoothly. To play Warcraft III, you need to use a mouse and keyboard – it was designed to be played on a PC.


  Being that this game is more than a decade old, you have to accept that the graphics will be pretty outdated and, by today’s standards, not that great.
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  Originally released in 2002, Warcraft III is the third game from the Warcraft game series. The Frozen Throne, an expansion pack, was released the following year, in 2003. You can buy Warcraft III directly from Blizzard’s battle.net shop for $9.99 (if you buy only the game without the expansion pack). This game has been such a big hit over the years that Blizzard is still actively updating it. The latest patch (version 1.29) for Warcraft III was actually released in April 2018 which is pretty impressive for a 16-year-old game. I was lucky enough to find the Warcraft III Battle Chest in Amazon for the low price of $6.99 in new condition. The Battle Chest includes Warcraft III: Reign of Chaos CD, Warcraft III Expansion: The Frozen Throne CD, and two bonus strategy guides from Brady Games. I was able to install the game from these CDs.


  You might be asking yourself, why Warcraft III? Certainly there are newer games to play, right? And, you’re right. There are certainly newer games to play, and we will get back to a newer Linux release in upcoming articles, but Warcraft III is an important game in more ways than one – which is the reason I’ve decided to install it, play it and review it.


  For those of you who may not be familiar with the Warcraft game series, and without getting too deep talking about the entire Warcraft series, let me explain the importance of Warcraft III. In today’s gaming world, the two names synonymous with successful online gaming are DotA 2 & World of Warcraft. Both of these games have their roots in Warcraft III. Let me explain…


  
    	First for the more obvious of the two: World of Warcraft. The Warcraft game series goes back over a decade. The first video game to be released from this series was Warcraft: Orcs & Humans back in 1996. Then followed Warcraft II: Tides of Darkness, and then Warcraft III: Reign of Chaos was released. Then in 2004 World of Warcraft was released.


    	Now, as far as DotA 2, it may not be as easy to see the relationship if you’re not a DotA gamer, so let me explain. With Warcraft III, there is a mod available that allowed for the original Defense of the Ancients (DotA) to be developed. Warcraft III includes a map editor which allows the player to create custom maps and custom games. It was through Warcraft III, and with the use of the map editor, that Icefrog developed and released the original Defense of the Ancients. In time, Valve (the company behind the game engine Steam), hired Icefrog and a few other game developers, and tasked them with developing a new game based on DotA. The end result was DotA 2. You can still play the original DotA, but in order to do so, you need to have Warcraft III installed.
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  So, as far as the game is concerned, it plays like a charm. This game has been out for a while, so you’d expect it to run smooth with today’s hardware, and it does. However, due to the fact that there are still new updates being rolled out for this game, it does mean that development hasn’t yet ceased and because of it, the folks at WINE are still actively trying to get the game to run smoothly on Linux. And they’re doing a great job of it.


  If you’re looking for a little bit of nostalgia, or maybe you want to play the game that was the stepping block for whatever your favorite game might be today, you won’t regret going through the hassle of installing a non-Linux game. Warcraft III is the first game I’ve reviewed here at Full Circle Magazine that required me to install and run WINE, and I’m happy to report back that this endeavor was a true success. The game was able to play smoothly, without any lag or glitches. However, getting the map editor to run in Linux is another headache that I haven’t yet submitted myself to suffer, so I can’t quite comment on how to use it nor on how to run and play the original Defense of the Ancients, but if I ever do, you better bet I’ll let you know about it in an article here. Chances are that I won’t, but you never know.


  3 ½ out of 5 stars


  
    Oscar graduated from CSUN, is a musician, game enthusiast and has been working with Bitcoin and other alt-coins. You can follow him at: https://twitter.com/resonant7hand
    or email him at: www.7bluehand@gmail.com
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  Ubuntu Games - Minetest + Mineclone2 = Minecraft


  Written by Ronnie Tucker


  
    NOTE: All in-game screenshots in this article are Mineclone2. NOT Minecraft.
  


  Several issues ago, I took a look at a free game called Minetest. It’s based on the ever popular Minecraft. It’s the same basic (blocky) look, but it lacks the gameplay where you’re running from creepers, zombies, et al. Well, Minetest now has an add-on called Mineclone2 which will make Minetest just like Minecraft complete with creepers and the like.


  Installation


  First, you need to install Minetest. This can be done either by downloading it from the Minetest site (https://www.minetest.net) and installing it, or, better still, use your distributions package manager.


  Now that you have Minetest installed, you need to install Mineclone2. Download the latest version (0.39.0 - for Minetest 0.4.16 as I write this) from: https://forum.minetest.net/viewtopic.php?t=16407.


  The download is a ZIP file. Open this either by double-clicking it, or using a right-click and choose ‘open with archive manager’. Whichever your desktop uses.


  Now, in your file manager, look in your /home directory for a folder called .minetest. This will probably be hidden and will need you to show hidden files. In Ubuntu this is done using the window menu (top right), then choosing ‘show hidden files’.
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  Now that you’re in the .minetest folder, create a folder called ‘games’. Go in to the .minetest/games folder.


  Drag the Mineclone2 folder from the archive manager into that .minetest/games folder.
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  That’s it! Mineclone2 is now added to your Minetest.


  Running


  Now, as normal, start Minetest.
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  The trick to getting Mineclone2 is to click the two little ‘dirt’ blocks at the bottom left of the shaded area.
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  That will tell Minetest to use the Mineclone2 add-on.
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  New Game


  Starting a game in Mineclone2 is just the same as in Minetest. You choose ‘New’. Give the world a name and a unique seed. I use Mapgen v7 as I find the worlds are more unusual looking. Oh, and make sure that Mineclone2 is selected before you click ‘Create’.


  Now, choose your game and click ‘Play Game’.


  Minetestcraftclone


  I think you’ll agree that the developer of Mineclone2 has done a fantastic job of making Minetest look like Minecraft. Yes, there are things that aren’t in Mineclone2 yet, but it’s a one-man operation, and it seems to be a case of the dev continually adding and tweaking existing add-ons to get it just right.


  All the basic stuff is there; digging, crafting, animals, enemies, and repeatedly dying.


  Just watch out for the Creepers. They’re even more lethal here than in Minecraft!
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  The current site was created thanks to Lucas Westermann (Mr. Command & Conquer) who took on the task of completely rebuilding the site, and scripts, from scratch, in his own time. The Patreon page is to help pay the domain and hosting fees. The yearly target was quickly reached thanks to those listed on this page. The money also helps with the new mailing list that I set up.


  Several people have asked for a PayPal (single donation) option, so I ’ve added a button to the right side of the website.


  A big thank you to all those who’ve used Patreon and the PayPal button. It’s a HUGE help.
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  https://www.patreon.com/fullcirclemagazine
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  https://paypal.me/ronnietucker
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  https://donorbox.org/recurring-monthly-donation
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  How to Contribute


  
    FULL CIRCLE NEEDS YOU! 

    A magazine isn’t a magazine without articles – and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org.


    We are always looking out for new articles to include in Full Circle. For help and advice, please see the Official Full Circle Style Guide: http://bit.ly/fcmwriting

  


  
    FCM #136 Deadline: Sunday 12th August 2018. Release: Friday 31st August 2018.
  


  
    	Send your comments or Linux experiences to: letters@fullcirclemagazine.org


    	Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org


    	Questions for Q&A should go to: questions@fullcirclemagazine.org


    	Desktop screens should be emailed to: misc@fullcirclemagazine.org


    	… or you can visit our forum via: www.fullcirclemagazine.org

  


  
    Full Circle Team 

    Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org


    Webmaster - Lucas Westermann - admin@fullcirclemagazine.org


    Editing & Proofreading:  Mike Kennedy, Lucas Westermann, Gord Campbell, Robert Orsino, Josh Hertel, Bert Jerred, Jim Dyer and Emily Gonyer


    Our thanks go out to Canonical, to the many translation teams around the world, and to Thorsten Wilms for the FCM logo.

  


  Getting Full Circle Magazine:


  EPUB Format - Most editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org


  Magzster - You can also read Full Circle online via Magzster: http://www.magzter.com/publishers/Full-Circle. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.


  Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.
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